
wieland

wiemarc 4.3

Guide to Using
wiemarc 4.3 Labeling Software

wieland
Elektrische
Verbindungen

Release: June 30, 07©



1. System Requirements ..................................................................................3

2. Software Installation .....................................................................................3

3. Selecting the Output Device and Changing Settings....................................3

4. Definitions.....................................................................................................4

5. Getting used to the Software ........................................................................5
5.1 Create a new project ..............................................................................5
5.2 Opening an existing project....................................................................5
5.3 Selecting tags / marking elements .........................................................5
5.4 Marking the selected tags / marking elements .......................................6
5.5 One-time, multiple and serial modes......................................................8
5.6 Importing files .......................................................................................10
5.7 Row labeling.........................................................................................12
5.8 Marking of endless strips......................................................................12
5.9 Copying functions.................................................................................14
5.10 Zoom function.....................................................................................15
5.11 Control print of the labeling data.........................................................16
5.12 Preferences ........................................................................................16
5.13 No. of projects and base plates allowed.............................................16
5.14 Information menu > ? .........................................................................16

6. Starting the Print Job with the wieplot 500 ................................................17

7. Scale Factor ...............................................................................................20

8. Designing new Tags ...................................................................................21
8.1 Example for same sized tags for plotting and engraving......................22
8.2 Example for different sized tags for plotting and engraving .................25

    8.3 Example for same sized labels for endless TT-Printer .........................27
8.4 Example for same sized labels for Office Printer .................................28
8.5 Example for different sized labels for Office Printer .............................29
8.6 Import / Export of User elements..........................................................30

Guide to Using
wiemarc 4.3 Labeling Software
Content

wieland Guide to using wiemarc 1



9. Engraving Tags...........................................................................................31
9.1 Engraving with wieplot 500 Engraver..................................................31
9.2 Starting the Engraving ..........................................................................33

10. Calibrating the Plotter. ..............................................................................37

11. Firmware update of the plotter ..................................................................38

12. Printing on other output devices ...............................................................39
      12.1 Printing on endless TT-Printer ..........................................................39
      12.2 Printing on standard Office Printer....................................................40

Guide to Using
wiemarc 4.3 Labeling Software
Content

wieland Guide to using wiemarc 2



1. System Requirements
Pentium II PC (200 MHz or higher)
64 MB RAM
CD-ROM drive
VGA graphics adapter and monitor (256 colors, resolution 640 x 480)
Operating system: Windows 98, ME, NT, 2000, XP, Vista (32bit)
Mouse

2. Software Installation
First close all other applications. Insert the “wiemarc” CD into the CD-ROM drive of
your PC. Installation will start automatically. Please follow the on-screen 
instructions. If the auto-start feature has been switched off on your PC, please start 
the set-up program by double-clicking. 
When the installation is complete, connect the plotter to the PC with the parallel
interface cable or USB -cable and switch the plotter on.
     
3. Selecting the Output Device and Changing Settings
Now start the wiemarc program by a double click on the symbol located on the
desktop. Before working with the software, you
must first install the plotter you intend to use. To
do this, select the output device in the window.
As example, if you are using the wieplot 500
select the output device and check the clickbox
as Use always this type of Printer. You will
not be asked any more in the future. With the
button Accept the setting will be saved and the
window be closed. 
If you like to connect another output device in the future, like the wieplot 500 (half
size) Engraver, endless Thermal-Transfer Printer or an Office Printer you can always
get back to the window from the Menu bar > File and choose > New. The wieplot 500
is default set as standard output device,
connected through the USB. In addition, 
the wieplot 500 has a parallel port, to be 
used with the wiemarc. For using you
need to change the output to parallel, go to
the main menu bar > Output > 
Output device and check the Interface tab.
Confirm LPT1 as the new interface port
and click on Apply. 
Connect the parallel cable on both ends
and switch on the wieplot 500, the
software will recognize the plotter accordingly.
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4. Definitions

Base Plate

Segment 4Segment 3Segment 2Segment 1

Example of
Label Sequences

displayed with 
Zoom Function

Plate 1

Zoom Function
click on Zoom Icon        Zoom on
position the mouse and click the right mouse button Zoom in (enlarge)
position the mouse and click the left mouse button Zoom out (reduce)
click on Zoom Icon        Zoom off
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5. Getting Used to the Software
Our prime concern when developing this software was that users should be able to
carry out all labeling jobs quickly and easily.
For this reason, every task follows the same basic pattern:

5.1 Create a new Project.
The wieplot 500 has an integrated support plate recognition system included. The
software wiemarc reads the code of each field, starting with the left support plate.
Assuming the wieplot 500 is turned on, the communication cable is connected and
support plates are placed on the plotter itself, the software pre-selects the marker
cards already. If you click on the icon      New Project of the menu bar, or select 
> File and > New from the main menu, the message comes up, if you like to use the
recognition system and
read the support plates.
After you confirm with Yes,
the support plates are
recognized and shown on the screen together with the available marker cards. If you
confirm with No, all available elements and manufacturer
are presented in the list to be selected from. 
After changing the support plate on the plotter or after
deleting a segment within the software, you could click on
the icon        Rescan support plates and read the new
support plates.

5.2 Open an existing Project
If you click on the icon       Open Project of the menu bar, or select > File and > Open
from the main menu, existing projects could be loaded. You are able to work with 
up to 10 different projects at the same time and could use all the Copy and Paste 
functions between them.

5.3 Selecting tags / marking elements
After you double click on one of the segments on the
screen, a list of the available marker you can work with 
and select from comes up. Just choose the type you have
placed on the support plate and the selection will be
presented on the screen.
If the no. of marker presented are not sufficient in order to
complete your job on one base plate (holding up to 4 support plates), new base plates
with respective support plates could be added upon your convenience.
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In order to do so, please select > Edit and > Add Plate from the main menu or use the
right mouse button. 
A new blank base plate comes up to be used with more
segments. Up to 16 base plates could be used in one
project (max. 10 projects in one file). 
To move from one base plate to the other just click on
their names in the lower left corner. Base plates could

also be renamed just with a double
click, or moved in the position to each other with drag
and drop.

5.4 Marking the selected tags / marking elements
Double-click the tag or element where the labeling process is to begin. 
This opens the labeling dialog box, which contains all the setting options. In order to
open the edit window, please click on the first tag to start with, use the right
mouse button and choose > Labeling from the menu or start typing a character on the
keyboard (check under > Option from the menu first). The exact description of the
selected tag and the number of tags available both appear in
the top line of the dialog box. 
An outline of the selected 
marking element is shown in the top third of
the box. 
Angle and text alignment options are found
next to this diagram. 
The number of lines per tag can also be
specified here. 

Note that the program will only allow
options that are appropriate for the
selected element.

The various tabs for different methods of data input and import appear in the middle of
the box. This is where you can enter all the data and text for one-time, multiple, and
serial marking, and files to be imported from different programs, as well as text for 
custom labeling (for example, row labeling).
The font, font width, font size, underline, line spacing, tip width of the plotter pen, and
plottingspeed settings can be adjusted in the lower part of the box.

wieland Guide to using wiemarc 6



The values match the chosen marking element, but can be altered within reasonable
limits. A warning message is displayed if text length exceeds the size of the tag.
This enables you to adjust the font, font size or font
width so that the text fits onto the tag
or element. 
From a certain font height upward, only capital
letters and certain special characters are allowed
in order to make best use of the available labeling
area. 
In such cases the following warning is displayed: 
> Only upper case letters, special characters
and symbols are allowed <
Characters as "g, j, y, Ä, Ö, Ü" are not allowed in order to make best use of the
labeling area.

      Restore Default values: 
If you change parameters (font types, text height, line numbers etc.) for
each element the data will be stored in a separate file. If you choose the element
again, you will find the previously used parameter settings. 
Click Default values , if you want to restore the original settings.

Note: After updating the software the user´s specific parameters remain valid.

      Extended character set 
Country specific characters are directly
available by selecting 
extended character set, the labeling
for other countries is easy to achieve.
Selecting the option, a new window
opens up at the right side with the 
provided characters.
Without looking into the windows 
character set for characters not 
available through the keyboard directly,
country specific characters can be 
selected with a click.
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Country specific characters will be
provided according to the selected
typeface, e.g. if you choose the
font ISO_3098_ee, characters for
eastern European countries are 
available.
Additional character sets such as
Cyrillic, Baltic, Turkey, Greek, will be
available by selecting the spec. font
under ISO_3089.

Also ornate fonts can be selected, 
specifically to be used for engraving.

5.5 One-time, multiple and serial modes
By choosing the tab for one-time, multiple, and serial modes, corresponding
sequences of text, numbers, characters and
symbols can be entered. At the right-hand corner
of the marking window you will find a large choice
of symbols which can be selected by a click.
The number of lines opened for editing
corresponds to the number of lines set per tag.
Text can now be entered. The number of tags to
be labeled with the same text should be
entered in the Repeat field. 
The data input is shown in the preview window.

If the number of repetitions exceeds the number of tags available, the following
warning is displayed: > Not enough tags selected to fit your request <, 
and the number of repetitions must
either be corrected or more tags
must be provided for labeling by
confirming with Yes.
Clicking OK transfers the labeling to the tags.
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If sequential numbering is to be carried out, after
selecting the number of lines you must specify 
the line in which the sequential numbering is to
appear. To allow this, the Series check box to the
right of the line is activated. 
Checking      this box then activates the 
consecutive no. button and prevents input in the
editing field. Clicking the Consecutive no. button
opens a further window, allowing serial marking to be
entered.
Here the start value, final value, preceding text (prefix), following text (suffix), step
size, counting method, and number of repetitions can be entered, the counting method
can be chosen to be in ascending order.
The count could be chosen in decreasing nos. (start
value higher than final value) or increasing nos. (start
value lower than final value).
The left part of the window is separated in two parts, 
primary serial number and secondary serial number,
in order to create two interlinked consecutive
numberings, with free chosen character for separation.
The example shows as primary series TP-1 to 5 and the
secondary series 10 to 15 –HA, with a separation
character of --, TP- is the preceding text (prefix) and
–HA the following text (suffix).

If the series labeling job specified exceeds the number of tags available, the following
warning is displayed: > Not enough tags marked for labeling <. 
The number of tags must either be reduced for example, by changing the final value or
more tags must be provided for labeling. 
The sequences entered are listed in the preview window. 
Clicking OK returns you to the previous window, and any necessary 
parameter changes can be made there. 
Clicking OK again transfers the labeling to the
tags. You can edit the data in the preview window.
It is possible to delete texts, insert empty rows and
special symbols or other texts.

Note: If you want to insert more data in series, 
sequences cannot be shown and edited in the
series modus.
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5.6 Importing files
After choosing the Import file tab, data can be imported from other files.
Data can be imported from other CAD/CAE programs, text files, 
or spreadsheet programs.
An efficient import function is available to allow 
extraction of the required data from a range of file
formats.
Clicking the Browse button makes it possible to 
locate the file to be imported. Click to
select the file name, and then click Open to 
access the file for importing.
A window will now open displaying the data for 
importing, in table format. 
You can choose the separator to be “tab”, “space”,
“comma” or “semicolon” as single or in combination. 
In addition further character can be defined by 
clicking the box Other and entered in the next field,
e.g. “B”, enter “B” in the field and confirm with OK.

Another possibility for separating imported files is the
no. of character. 
Select the click box Text length fixed and enter the
no. of character in the empty field, clicking OK 
activates the new separator.

If you want to import wiemarc, Excel, Access or E-Plan files, the program will 
automatically recognize the format and open the first worksheet for importing. 
This is the default setting . You can also select other sheets from the file.

You can now copy either part or the entire table and use it for marking. 
Please follow these steps:
Use the mouse to select individual or multiple cells, 
individual or multiple columns, individual or multiple
rows, and click the Copy marked range button. 

The data will be inserted into the editing field, and
you can check whether the copied data is correct. 
It is possible to edit the data in this window, like input of new
data, delete data, correct data and copy data.
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The following functions exist to aid data import:
Overwrite existing data

If you enable this function, newly copied data will automatically overwrite previously
copied data. If this function has not been enabled, the data will be appended to the
existing data.

Ignore null values
If this function is enabled, cells containing no data 
will not be imported.

Left        Right
This function allows the import sequence to be 
changed. In the default setting, the data is transferred
by column from top to bottom. If the left-to-right 
function is enabled, the data is transferred by row
from left to right.

Data can also be easily imported from files using Copy and Paste and the Windows
Clipboard.
To do this, open the relevant file and copy the data to the Clipboard. 
When the original file has been closed, the data on the Clipboard can be pasted into
the editing field on the right-hand side of the import box either by pressing the 
Ctrl V keys or by using the shortcut menu which pops up after clicking 
the right mouse button.
After the data has been transferred to the preview window, it can be modified as
required. Available functions include deleting data, inserting data, etc.
Clicking OK transfers the labeling to the tags.

If the number of requested tags exceeds the number of tags available, the following
warning is displayed: > Not enough tags selected to fit your request <, 
and the number of imported tags must either be corrected or more tags must be
provided for labeling.

Another direct import function is available from the main menu, 
select > File and > Import file.
The import filter is specially designed for the import of files created
by former software programs, supporting a direct import of a 
complete marker card.
There is no “select from” available, the file is recognized and 
opened in the background upon importing the data. The software
opens the dedicated segment on a new base plate and transfers
the labeling to the tags accordingly. Post import of the data, all edit
functions can be used as previously described. 
Special import formats are available at sales support.
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5.7 Row labeling
After choosing the row labeling tab, marking can be easily carried out on individual
row. Please ensure that you have selected complete row, since otherwise proper 
labeling will not be possible.
The editing field is used to enter the text to be printed on the
row. The characters for each tag must be separated by 
commas for example, “ab, cd, ef, symbol, symbol” means print
“ab” on the first tag, “cd” on the second tag , “ef” on the third
tag, "symbol" on the forth tag and "symbol" on the fifth tag .
Clicking OK transfers the labeling to the tags.
 

5.8 Marking of endless strips
This software has special features for marking of endless strips:

 Strip partitioning
 Marking complete strip
 Marking strip section
 Copy a strip
 Insert a strip

If you choose strip-material, the above mentioned functions for
sectioning and marking of strips are available on the menu > Edit.
By clicking you can select the strip you wish to mark.
Note: In order to mark a section of strip you have to prepare it first
via menu > Edit > Strip partitioning.

 Strip partitioning
You can open a window via > Edit > Strip partitioning which 
allows you to divide the strip into various sections.
First put in the width of the strip and then the amount of 
elements required in that width and confirm by pressing the
button Append .
Thereafter you can select and add further sections with 
different widths.
If you wish to insert a section between other sections you have to mark-out the
section before which you want to insert. 
Then press the button Insert to start the process.
You can delete sections by marking-out the section and pressing the Delete button.
At the bottom part of the window you can check strip-length already occupied and the
remaining strip-length.
After completion of sectioning press OK button and the strip will show up with the
corresponding divisions.
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 Marking complete strip
Mark-out the required strip by clicking. 
Via the menu > Edit > Marking complete strip you
can get to the labeling window in which
you can select the type of marking. This 
function allows you to carry out marking 
in multiple and serial mode in various 
element-widths.

Note: The space available for marking is calculated on the lowest
element-width. Should you request an individual marking on the
various element-widths, please choose this marking possibility
over the menu by selecting > Edit > Marking strip section

 Marking strip section
Mark-out the strip section you want to work on by clicking. 
Via menu > Edit > Marking strip section you can open the labeling
window and can select the print. This function
allows you to completely utilize the available element-width.

Note: Cut markings can be added to the print output. The settings
are made in the print output menu (see chapter “Printing Tags”).

 

 Copy strip / Insert strip
Mark-out the strip you wish to copy by clicking. 
Via menu > Edit > Copy strip you can prepare the copy process.
Now click to the strip onto which you want the data to be
inserted. Via menu > Edit > Paste strip the data will be inserted.
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5.9 Copying functions
To avoid having to repeatedly enter the same or similar sequences, the program 
provides a multiple number of copying functions:

5.9.1. Copying a marking sequence
Select a sequence by clicking it with the left mouse button. Now click the right mouse
button and choose > Copy marking (only tags with text) from the
shortcut menu.
Then use the left mouse button to select the element where the
copied sequence is to be inserted. 
Open the shortcut menu by right-clicking and choose 
> Paste marking. If desired, the sequence can be altered. 
The copy/paste functions can also be accessed via the 
icons       /       on the toolbar or by choosing > Edit from the 
menu bar.

5.9.2. Copying several marking sequences
To copy several sequences, you can use the Shift - key to extend and select the area
to be copied. Copy and paste as described above.
Note: Simultaneous copying of multiple sequences to other types of tags 
is not possible.

5.9.3. Copying parts of marking sequences
To copy individual markings from within sequences follow these steps:
Hold down the Ctrl - key and select all the labels you wish to copy by clicking them
with the left mouse button. Copy and paste as described above.
Note: Simultaneous copying of partial marking from multiple sequences to 
other types of tags is not possible.

5.9.4. Copying of marking with empty signs
If you want to copy a range of tags, including non marked tags, mark these 
and click the right mouse button, select in the menu 
> Copy marking (including signs without text). 

Copy and paste as described above.
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5.9.5. Copying a complete segment with tags
Choose the segment with a mouse 
click. Press the right mouse button,
select in the menu > Copy segment
and activate it. Go to the destination
segment and click the mouse to
activate it. Press the right mouse
button and select in the 
menu > Paste segment
Using the menu bar > Edit and sub menus copy and
paste works in the same way as described above.

5.9.6. Copying an entire base plate
Choose > Edit from the menu bar, 
followed by > Copy Plate. 
Choose again > Edit from the menu
bar, followed by > Paste Plate.
The whole plate will be copied
automatically.

5.9.7 Copying of texts onto other tag sizes
In some cases, the copying function of text to other tag sizes is disabled. It is only 
allowed to copy in a common sense. The preview of the print must fit on the tag, like
writing angle and text size. 
In general only one sequence can be copied at a time.

Note: All copy functions described can also be used between projects.

5.10. Zoom function
In order to activate or deactivate the zoom function, choose > View > Zoom function
from the menu bar or click on the       icon. 
Click on the icon once and move the mouse to the position on the base plate you like
view differently. With the left mouse click the position will be taken as new screen 
center and enlarged. A new click on the       icon will deactivate the function, continuing
to work with the current zoom. 
The click with the right mouse button reduces the screen by a given zoom factor.
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5.11 Control print of the labeling data
You can send the print data to a standard printer by selecting 
> Extras from the main menu.
Print all segments:
The printer prints two quarter size segments per page, a two page
printout from the wieplot 500 full size
Print selected segments only:
The printer prints one page with the selected segment.

5.12 Preferences
Choose > Extras > Options from the menu bar for opening the window to select form.
To select the language please check the next window coming up.
Before the plot starts a message comes
up, reminding you how to treat the 
plotter pens. If you don´t like to have it
come up please check the mark. If you select a tag ready for labeling,
you can just start to enter the character on the keyboard as 
first character accepted, the labeling window opens and the character
is placed on the selected tag. If you don´t like to have it in place please
check the mark.
 
5.13 No. of projects and base plates allowed
Choose > Windows from the menu bar in order to receive the 
overview of your actual project no. and base plates activated. 
In total you can have up to 10 different projects and up to 16 base plates from each
project open and work with.

5.14 Information menu > ?
Choose > ? from the menu bar to receive further information about the system.
If you select Support plates, a window with different lists comes up, 
showing the actual available support plates, the description and part no. 
If you select Online-help, a description of general features of the software
is available. You can click within the software at any time on the       icon or open the
help file from the menu bar > ? > Online-Help.
The information window opens from the 
menu bar > ? > Information with important information
about the software version, the release of the database
and the firmware of the wieplot 500. 
To close the window click on the OK button.
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6. Starting the Print Job with the wieplot 500
Once all the data for printing the job are entered the tags can be plotted. 
In the upper left corner of the screen you will find the 
information.                     In order to start printing, the plotter needs to be switched on
and connected with the respective data cable. 
Click on the printer       icon in the main menu bar. Prior
to starting, the software verifies if the plotter runs in the 
plotting mode. If you are using the engraving option for
this plotter also, the plotter could be in the engraving
mode. If that is the case, you will find some instructions
on the screen how to switch the plotter into the plotting
mode. After confirming the message the
status will be re-checked.
Now the software verifies if the selected
support plates are identical with the ones
placed on the plotter, if not, a warning message comes up on the screen you need to
confirm. 

Following new information are displayed and adjustments could be selected from:
 

 In the top part of the window the selected
plotter and interface are indicated. 

The next click box you can
check to activate or deactivate priming the
plotter pen on one of the fields left or right of
the Pen Station.

 The next field of the window indicates the 
recognized support plates, placed on the
plotter. Are those different from the ones 
chosen for this project, the necessary support
plate for this job is indicated in red.

 The right side of the window is used to show the different plotter pens to be used for
this job, also with a color indication according to the standard color coding of the 
EK-TEAM Plotter Pens. 

If the tip of the pen used is larger than .5 mm a message comes up, telling that the
standard pen sizes (.18 mm to .5 mm) for
this job will be different.
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 Different print options could be set up in the lower part of the window:
     
     Use one Plotter Pen Size only
In order to execute this job, two or more pens
to be used might be indicated. If you
like to use one tip size, please check this box
and select the respective Pen.

     

     Use Pen inserted in Pen Holder
Once checked this box, no Pen will be picked
up from the Pen Station. The pen directly 
inserted into the Pen Holder will be used. This
option could be used, if pens
used are different from the EK-TEAM Pens, although they might have a HP compatible
outside dimension, but will not fit into the Pen Station of the plotter.

     Use one Plotter Speed only
In order to execute this job, different speeds (10 to 40 mm per second) could be
selected from the data entry. In order to work with one speed selection only, please
check this box and select the respective speed.

     Print selected tags only
If you check this box, only the tags marked before are subject to be printed.

Select a sequence
Just click in the edit window on the sequence once and it is marked.
Select multiple sequences
Just click in the edit window on the first sequence once, hold down the
Shift Button and click on the next sequence ones etc. and all are marked.

 Select single tags
Hold down the Ctrl Button and just click in the edit window on the single 
tag or multiple tags once and they are marked.

     Print selected segments only
If you check this box, only the segments marked before are subject to be printed.
Just click in the edit window on the segment once and it is marked. In order to mark
two or more segments, hold down the Ctrl Button and click on each segment once.
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     If you print on endless strips, additional adjustments are subject to be
checked.

Insert a cutting line
No 

no cutting line is printed

Yes 
cutting lines are printed after each tag length

Final 
cutting line is printed after the last tag of the
whole strip length

The print job starts with a click on the OK Button.
The software checks again if the selected support plates are placed on the plotter. 
If not, a warning message comes up to be 
confirmed, either continue or cancel.

In case the already started job should be stopped, please click on the 
icon       Stop Plot in the menu bar. The printout will be interrupted and the data 
(if any left) in the print spooler of the PC and the wieplot 500 will be deleted. 

The wieplot 500 will re-align and move back to the origin, waiting for the new job.

Alternative the power of the wieplot 500 can be re-cycled by pressing the OFF and
ON button. All existing data will be deleted and the zero position re-aligned.

Other plotter connected might be different in the operation, please refer to the
instruction manual.
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7. Scale factor
The data created from each individual tag for the database was carefully investigated,
although they are not frequently checked. There could be a chance for the printable
tags to receive by the time a slight mechanical deviation, spec. in the scale factor, 
means the distance from one tag to the next in both of the directions x and y. 
Temperature and humidity at the work bench could influence the distance as well as
new production series and different production techniques during the process like 
material and temperature changes. Covering the complete x and y dimension of the
marker card, deviations of  > 1 mm are noticeable. In order to be able to correct the
settings a special function is provided under menu > Extras > Elements> Scale factor.

Once a segment with a marker card is placed on the 
wieplot 500 the first upper left tag should be
checked, if the print is centered in both directions 
(see also item 10 Calibration). There after the last tag
at the lower right corner needs to be printed in the
same manner. If not printed exactly the same,  the
scale factor for this particular card is 
not perfectly correct.

In order to correct the scale factor select one tag on the segment and choose 
> Extras> Elements and > Scale factor from
the menu. The tags are changing into red and 
the wieplot 500 moves with the inserted pen or
magnifying tool to the lower right corner to the 
point of the beginning of the last tag. 
With the button Pen Up /Down the plotter pen 
or magnifying tool can be lowered in order to 
find exactly the correct spot of the beginning of 
the last tag at the lower right corner.
You can move the arm of the plotter with the four cursor buttons in
the pre-selected steps from 0.025 mm up to 10 mm, the default value is 0.1 mm.
After completion you must press the button Accept in order to save the changes to the
user file within the database, the general database is always kept original. 
Closing the window moves the plotter arm back to the previous position.
The next start of the software will take the changed information from the user data-
base. You can return to the original values by clicking the Reset button.

The complete dimension in x and y direction can be changed with the correction of the
scale factor. Re-check the result of the print again by printing the last tag at the lower
right corner, centered in both directions.

scale in x-direction

scale in
y- direction
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8. Designing new Tags
This part of the program allows you to design own tags and elements or labels.
In order to open the program, choose > Extras and > Elements from the main menu.
To open the designer for labels for the endless
TT-Printer and Office Printer choose > Extras and
> Labels  from the main menu.

There are two versions available 
designing new tags:

 Design tags with same size
 Design tags with different sizes

If you like to design e.g. a label sheet with same sized labels in a matrix, use
> Design tags with same size. If you like to design e.g. a serial no. plate with different
sized label areas, use > Design tags with different
sizes.

Note: Designing tags is only possible with a plotter as
output device selected. If you are working with the 
engraving feature, the software suggests to use either
the half (DIN A4) or full size (DIN A3) plotter.

The use of the design program is described below, 
after saving, the designed elements or labels are available for labeling in the folder
> User defined under > Producer (manufacturer) after selecting the correct output
device..
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8.1 Example for designing a label sheet (matrix) with same sized labels for 
plotting and engraving
Open the designer from the main menu with > Extras > Elements 
> Design tags with same size as described above.

The following window appears:
With a click on the button New a new element can be named in the window under 
<Untitled>. It is useful to work with the element recognition system of the plotter in 
order to find the element more easy later on.
For the element you want to design, enter a new
name in the window <Untitled>.
If you don´t want to use the element recognition 
system or you are working offline (without being
connected to the wieplot 500), select the type of
support plate for the sheet. 
You can select between a quarter size, half size
or full size support plate. 
You can always assign the support plate to the
project later on. As soon as you are connected back to the plotter place the 
support plate and click on the button Assign support plate identification.  
Pre-selected is the plate for sheets (half size plate).

Further you can select in the lower left part of the window, if the new designed 
material is for plotting only or plotting and engraving. The buttons are only active 
once the support plate is recognized or assigned to the project.

Once selected, click on the Edit button.

Note: Engraving is only possible on dedicated support plates.
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A new window opens up, 
where you can enter the data
of the tag (size of the label), 
if known.
You can always take the 
measurements using the 
plotter system, if the data is
not available.
You need only to enter the
nos. of tags in x and y 
direction. 

All other data necessary for the program, can be taken with the plotter system.
Please enter the no. of  tags in x and y direction as shown in the window.
If available enter also the size of the tag (label) and the distance to the next tag. You
can always correct the data later on, if the exact nos. are not present at the moment. 
Always take the start position of the first tag with the plotter system!
Further on, you can decide on the labeling direction of the tags. 
For the sequence for plotting or engraving you can choose between upper left to upper
right (by row) or upper left and lower left (by column).

Attention: It is essential for continuing the design to switch on the plotter and have the
support plate with the label sheet placed on. 
Insert a plotter pen directly into the pen holder of the plotter.

If you have entered minimum the no. tags (label) in each direction, please click on the
Take measurements button.

A new window opens up, providing
buttons and entry windows, in order
to take all relevant measurements
for the new element.
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Please follow the steps for taking measurements:

 
 Determine the exact position of the

first tag on the label sheet. In order to
do so, please click on the most left
button Initial position of the window.

The arm of the plotter moves to its upper left corner limit (zero position). From there
you can move the arm with the pen inserted to the upper left corner of the first tag with
the cursor buttons. You can select the size per step in mm in the upper right area of
the window. 
Please check with the Pen Up/Down button the correct position after you moved the
pen to the initial point of the tag. The respective co-ordinates are shown in real nos. in
the x- and y- window based on the zero position.

 Determine now the exact position
at the lower right corner of the first
tag. Just repeat the steps as for the 
upper left corner, described above. 

 

 

 As next step, determine now the
exact position of the upper left corner
of the last tag (size of matrix). 

Take the initial position in the same
manner as described above.

After completion of the three steps all measurements are taken for the element.
In order to save the data for the new element, please click on Accept.
The window "Take corner measurements of tags" will be closed and you are back to
the previous window.
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Please click on the button Accept in the window and the new designed 
element will be shown.                                                                  
Now you can check, if all
the data where taken 
correctly. Any up-coming
error or warning message
at this point means,
please re-check the data 
manually or allow the automatic correction by the program. 

Click on the button Close in order to 
terminate the designer program. 
You can find the new element for 
labeling in the folder > User defined 
under > Producer.

Note: All new elements in the folder User defined will continue
to be available after program updates.

8.2 Example for designing a plate with different sized label areas 
for plotting and engraving

Open the designer from the main menu with > Extras > Elements > Design tags with
different sizes.

The same window appears, as described before for designing
tags with the same size. All adjustments will be done in the
same manner. 
After clicking on the button Edit a similar window
appears, extended by additional functions.
Now you have the ability to implement different
sized labeling areas. Each new area or field
needs to have an own name. 
Taking the measurements is now similar to the
previous sample of the label sheet matrix.

Example
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In case you like to copy the labeling field and place it at a different y-position, click on
the Button Duplicate. Please enter the new position in the new upcoming window and
confirm the entry by clicking on Accept.

Note: The new labeling areas could be part of a label sheet (matrix) as well as a single
area.

Please click on the button Accept in the
previous window and the new 
designed element will be shown. Now you can
check, if all the data were taken correctly. 

Click on the button Close in order to terminate
the designer program. You can find the new
element for labeling in the folder 
> User defined under > Producer.

In case the labeling is not exactly centered, you are allowed to edit the new designed
elements at any time. Open the designer program again, choose the element or part 
of the element you want to change and click on the button Edit for making the 
adjustments.

Note: All new elements in the folder > User defined will continue to be available after
program updates.
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8.3 Example for designing same sized labels for endless TT-Printer

Open the designer from the main menu with > Extras > Labels 
> Designer endless labels as described above.

The following window appears:

With a click on the button New a new 
element can be named in the window under
<Untitled>. 
Confirm the new name by clicking on Edit
and the new window for entering the data of
the label will open up. 

Take the measurements of the label and the distance between two labels. 
Enter the data into each field incl. the no. of labels in x-direction, 
confirm the entry with Accept and the labels will
be shown as designed. 

Please check if all measurements were taken
correctly. With Close the designer will be 
terminated. 

After selecting from the main menu > New the
correct output device, the designed labels are available for labeling in the folder 
> User defined under > Producer (manufacturer).
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8.4 Example for designing same sized labels for Office Printer

Open the designer from the main menu with > Extras > Labels 
> Design label sheets with same size as described above.

The following window appears:

With a click on the button New a new 
element can be named in the window under
<Untitled>. 
Confirm the new name by clicking on Edit
and the new window for entering the data of
the label will open up. 

Take the measurements of the label, the distance between two labels and the start
point from the left and upper side. Enter the data
into each field incl. the no. of labels in x- and 
y-direction, confirm the entry with Accept and 
the labels will be shown as designed. 

Please check if all measurements were taken
correctly. 

With Close the designer will be terminated. After
selecting from the main menu > New the correct output device, the designed labels
are available for labeling in the folder > User defined under > Producer (manufacturer).
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8.5 Example for designing different sized labels for Office Printer

Open the designer from the main menu with > Extras > Labels 
> Design label sheets with different sizes as described above.

The same window appears, as described 
before for designing label with the same 
size. All adjustments will be done in the s
ame manner. 
After clicking on the button Edit a similar 
window appears, extended by additional
functions.

Now you have the ability to implement different sized labeling areas. Each new area 
or field needs to have an own name. 

Taking the measurements is now similar to
the previous sample of the label sheet 
matrix. 
In case you like to copy the labeling field and
place it at a different y-position, click on the
Button Duplicate. 
Please enter the new position in the new upcoming window and confirm the entry by
clicking on Accept.

Note: The new labeling areas could be part
of a label sheet (matrix) as well as a single
area.
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8.6 Import / Export of User elements

You can import or export user designed elements and exchange with other 
users (created as described in chapter 8.1 and 8.5).

To export an user designed element, click on the 
button Export and select the folder saving the .txt-file.
The file name is suggested as the element name. 
Exported files can be imported at another work 
stations.

To import an user designed element, click on the 
button Import and select the file to be imported. You
can find the new element in the User defined folder. 
You can overwrite an already existing name for an 
element.

wieland Guide to using wiemarc 30



9. Engraving Tags
Please select the output device first in order to start engraving with the 
wieplot 500 Engraver (see also chapter 3 page 3). In the upper left corner of the
screen you will find the information..
Connect the engraving unit according to the manual and switch on the Controller 
wieplot VEC 500 first, followed by the plotter wieplot 500.
The steps getting used to the software, starting at chapter 5, are not changed using
the engraver. Just where the functions are different or additional a new description is
implemented into the manual as described in the following.

9.1 Engraving with the wieplot 500 Engraver
Double-click the tag or element where the engraving process is to begin. 
This opens the labeling dialog box, which contains all the setting options. In order to
open the edit window, please click on the first tag to start with, use the right
mouse button and choose > Labeling from the menu (see also chapter 5.4) or start
typing a character on the keyboard (check under > Extras> Option from the menu
first). 

Further adjustments using the engraving tool
are available by clicking on the button
Adjustments Engraving Tool
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Following adjustments for the engraving unit could be made and selected from.

    Size of tool
Engraving needle in the size of .2 mm up
to 1 mm could be selected from.
    Engraving speed
Adjustments of 2 mm/s up to 20 mm/s
could be selected from
    Revolution per minute (RPM)
Adjustments of 5,000 up to 50,000 RPM
for the engraving spindle could be selec-
ted from
    Penetration speed
Adjustments of 0.1 mm/s up to 1 mm/s could be selected from in steps of .1 mm/s
The type of the tool and the penetration depth will be suggested according to the 
selected engraving material.

       Restore Default values: 
If you change the above parameters for each element the data will be stored in a
separate file. If you choose the element again, you will find the previously used
parameter settings. 
Click Default values , if you want to restore the original settings.

Note: After updating the software the user´s specific parameters remain valid.
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9.2 Starting the Engraving
Once all the data for engraving the job are entered the tags can be engraved. In the
upper left corner of the screen you will find the information. 
In order to start engraving, the engraving unit needs to be installed and 
connected according to the manual. There after switch on the engraving 
controller wieplot VEC 500 first followed by the plotter wieplot 500.
Click on the printer     icon in the main menu bar. 

Prior to starting, the software verifies if the plotter
runs in the engraving mode. If the plotting mode is
detected, you will find some instructions on the
screen how to switch the plotter into the engraving
mode. 
After confirming the message the status will be 
re-checked.

Now the software verifies if the selected support plates are identical with the 
ones placed on the plotter. If not, a 
warning message comes up on the screen
you need to confirm.

Following new information are displayed and
adjustments could be selected from:

 In the top part of the window the 
selected plotter and the used interface is 
indicated. 

 The field below in the window indicates the 
recognized support plates, placed on the
plotter. Are those different from the ones 
chosen for this project, the necessary 
support plate for this job will be indicated in
red.

 The right side of the window is used to 
show the different engraving needles to be
used for this job, also with a color indication.
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 Various engraving options could be set in the middle part of the window:

     Only one engraving tool and depth to be used
In order to execute this job, two or more 
engraving needles to be used might be 
indicated. If you like to use one needle size 
and penetration depth only, please check this
box.
     
     Only one engraving speed to be used
In order to execute this job, different engraving
speeds (2 to 20 mm per second) could be
selected from the data entry. In order to work
with one speed selection only, please check this
box and select the respective engraving speed.

     Only one revolution speed (RPM) to be used
In order to execute this job, different revolution speeds (5000 to 50000 RPM) for the
engraving spindle could be selected from the data entry. In order to work with one
selection only, please check this box and select the respective revolution speed.

     Only one penetration speed to be used
In order to execute this job, different penetration speeds (0.1 mm to 1 mm per second)
for the engraving needle could be selected from the data entry. In order to work with
one selection only, please check this box and select the respective penetration speed.

     All selected tags will be engraved
If you check this box, only the tags marked before are subject to be engraved.

Select a sequence
Just click in the edit window on the sequence once and it is marked.
Select multiple sequences
Just click in the edit window on the first sequence once, hold down the
Shift Button and click on the next sequence ones etc. and all are marked.

 Select single tags
Hold down the Control Button and just click in the edit window on the single
tag or multiple tags once and they are marked.

     All selected segments will be engraved
If you check this box, only the segments marked before are subject to be engraved.
Just click in the edit window on the segment once and it is marked. In order to mark
two or more segments, hold down the Control Button and click on each segment
once.
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 Various options for the frame are available in the lower part of the window:

     Reverse labeling
With this option selected, the lettering will be reverse engraved. You will have a clean
surface at the front, engraved from the back side. Useful for engraving 
letterings used in harsh environments, no 
particle could stick in the engraved groves
making the lettering unreadable 
(specific material required).

     Engrave frame around lettering
With this option selected, a frame will be 
engraved around the lettering. First the 
lettering will be engraved. Thereafter the 
engraving process stops asking you in a 
message box to change the engraving needle
or to alter the engraving depth. If no tag is 
selected, all frames around the tags will be 
engraved, even if they don’t carry any 
lettering.

     Engrave frame only
With this option selected, the frame will be engraved only without the lettering. This se-
lection is useful engraving multiple depths on thicker material. Using first a lower pene-
tration depth and for the second run the final setting.

     Round frame corners
With this option selected, you can select in a combo box various 
radius settings for the corner engraving of the frame. Possible settings for the radius
are between 1 mm and 5 mm in .5 mm steps.
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The engraving job starts with a click on the OK Button.
The software checks again if the selected support plates are placed on the plotter.  
If not, a warning message comes up to be 
confirmed, either continue or cancel. 
There after the software reminds you by a 
message to verify, if the selected engraving needle is inserted into the spindle. 
This message needs to be confirmed with a click on the 
OK Button and the engraving job starts.

In case the already started engraving job should be stopped, please click on the 
icon       Stop Plot in the menu bar. The engraving will be interrupted and the data 
(if any left) in the print spooler of the PC will be deleted. 

The wieplot 500 Engraver will move back to the origin, waiting for the new job.

Alternative the power of the wieplot 500 can be re-cycled by pressing the OFF and
ON button. All existing data will be deleted and the zero position re-aligned.  

For further information, please refer to the operating instructions of the 
wieplot 500.
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10. Calibrating the Plotter
The wieplot 500 is calibrated during the production. In case of small deviations, like
the printout is not correctly in the center of the marker, the plotter could be calibrated
manually. 
In order to do so, please make sure there are no parts on the plot field, like ball
pen, not proper mounted support plates etc., then go to the 
menu > Output > Output device and choose > Calibration.
The arm moves into the center position. 
In the window on the screen you have 4 cursor buttons in order to move the setting in
either direction, in steps .025 mm up to 10 mm, the default setting is .1 mm. 
Each click in the button will move the Pen holder 
connected to the arm into the desired direction. After
the changes made, hit the Calibrate button and the
new settings are stored in the software. 
Please check again during the next print, if necessary
use the calibration function again until the output 
performance is satisfied. 
Use always the first tag at the upper left corner of the
segment (see also item 7 Scale factor).
The Reset button takes you back to the original 
setting. 

Although the other output devices you might want to use are pre-calibrated, because
of the different starting point, the calibration procedure as described is essential with
those other devices.
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11. Firmware update of the plotter11. Firmwareupdate des Plotters11. Firmware update of the plotter
With this option you are able to update the existing firmware of the plotter. 
It is necessary e.g. if you are using a wieplot 500 plotter already, purchased in 2005 
or earlier and now wanted to use the engraving feature.

In order to download a new version, please follow the steps as described: 
Start the program wiemarc and switch on the plotter. Make sure the plotter is 
connected with the interface cable to the PC and the interface is selected correctly
(see point 3).

Choose from the main menu > Output > Output devices the tab > Firmware update.

The upcoming window shows the actual firmware in
nos. A later version of the firmware is shown in the
field below with a higher no.

Now you can update to the next level of the firmware. 

If the later version is not in the pre-selected folder,
please use the Browse button to search for in
another folder.

With a click on the button Update a new message window opens up. 
You are asked to switch the plotter into the download mode. 

In order to do so, turn off the
plotter, hold down the button
Clear buffer and the button STOP together and press ON again.
The control LEDs STOP and Clear buffer are on.

Confirm the setting with the OK button and the update process
starts. A new message opens up telling you the plotter will turn off
automatically after completion. Confirm with the OK button. 

In order to check if the new firmware is stored correctly in the plotter,
turn on the plotter again and choose from the main menu > Output > Output devices
the tab > Firmware update. In the field “Actual firmware version” should now be the no.
of the latest version.
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12. Printing on other output devices
With the connection of other output devices, labeling data could be printed on 
Thermal-Transfer Printer (TT-Printer) as well as standard Office Printer. 
As described in chapter 8 the labels need to be designed first.

12.1 Printing on endless TT-Printer
Please select first the output device from the main menu > File > New.
In the upper left corner of the screen you will find the information. 
The 
designed labels are available for labeling in the folder > User defined under 
> Producer (manufacturer). 
Enter the labeling data in the editing window as
usual. The data can be changed and modified as
described in chapter 5.4 to 5.6.
By selecting a margin, a fixed distance within the
label can be set, making sure the print is always
within the label area. 
In addition the text can be manipulated for printing
in Bold, Italic, Underline, clicking OK transfers the
data to the label. 
After all entries are completed, 
click on the icon      Print / Plot / Engrave.

A message window opens up with the information to 
select first a system printer, clicking OK opens the 
window with the available printer list, please select 
the TT-Printer. 

If necessary you can change the size of the label just
to perform a final correction of the total length by 
entering a factor. 

Clicking on Apply, opens the print window with the
possibility of entering the margin to the left border of
the endless labels.

Please confirm with OK and the printout will be
started. 
Please check the print on the label regarding
the position, if necessary change the entry of
the left border margin or go back to the 
designer and make the corrections in view of
size and distance of the label.
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12.2 Printing on standard Office Printer
Please select first the output device from the main menu > File > New.
In the upper left corner of the screen you will find the information. 

The designed labels are available for labeling in the folder > User defined under 
> Producer (manufacturer). 
Enter the labeling data in the editing window as
usual. The data can be changed and modified as
described in chapter 5.4 to 5.6.

By selecting a margin, a fixed distance within the
label can be set, making sure the print is always
within the label area. 
In addition the text can be manipulated for printing
in Bold, Italic, Underline, clicking OK transfers the
data to the label. 

After all entries are completed, click on the icon      Print / Plot / Engrave.

A message window opens up with the information to 
select first a system printer, clicking OK opens the 
window with the available printer list.
Please select the Office Printer you like to use for the 
printout. 
In addition you need to enter the data of the 
non printable areas from the top and left in both of the
formats, portrait and landscape. 

Click on Test page in order to print the two pages 
for you to take the measurements from the 
top and left side, enter the data and click on Apply.
The data are stored for the selected printer and the
print window opens accordingly.
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In the top part of the window you enter the no. of copies, in the lower part you 
have the following choices to select from:

     Print frame around lettering
With this option selected, a frame will be
printed around the lettering.

     Print frame only
With this option selected, the frame will be
printed only without the lettering.

     All selected tags will be printed
If you check this box, only the labels marked before are subject to be printed.

Please confirm with OK and the printout will be started. Check the print on the label 
regarding the position, if necessary change the entry of the upper and left border 
margin or go back to the designer and make the corrections in view of size and 
distance of the label.
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